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COMMON COMPETENCY\ 

Perform 
Computer Operations 

Different Types of Computers 

Learning Objectives: 

After reading this information sheet, YOU MUST be able to identify the 
different types of computers. 

Computers have revolutionized all types of industries. They have 
proved a boon to mankind. What are the different types of computers? To 
know them all, read on… 

1. Types of Computers 
 

A computer is one of the most brilliant inventions of mankind. Thanks to the 
computer technology, we were able to achieve an efficient storage and 
processing of data; we could rest our brains by employing computer memory 
capacities for storage of the information. Owing to computers, we have been 
able speed up daily work, carry out critical transactions and achieve 
accuracy and precision in work output. The computers of the earlier years 
were of the size of a large room and were required to consume huge 
amounts of electric power. However, with the advancing technology, 
computers have shrunk to the size of a small watch. Depending on the 
processing powers and sizes of computers, they have been classified under 
various types. Let us look at the classification of computers. 

 
Different types of Computers 

Based on the operational principle of computers, they are categorized as 
analog computers and hybrid computers. 

 
Analog Computers: These are almost extinct today. These are different 
from a digital computer because an analog computer can perform several 
mathematical operations simultaneously. It uses continuous variables for 
mathematical operations and utilizes mechanical or electrical energy. 

Hybrid Computers: These computers are a combination of both digital and 
analog computers. In this type of computers, the digital segments perform 
process control by conversion of analog signals to digital ones. 

Following are some of the other important types of computers. 
 
Mainframe Computers: Large organizations use mainframes for highly 
critical applications such as bulk data processing and ERP. Most of the 
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mainframe computers have the capacities to host multiple operating 
systems and operate as a number of virtual machines and can thus 
substitute for several small servers. 

 
Microcomputers: A computer with a microprocessor and its central 
processing unit is known as a microcomputer. They do not occupy space as 
much as mainframes. When supplemented with a keyboard and a mouse, 
microcomputers can be called as personal computers. A monitor, a keyboard 
and other similar input output devices, computer memory in the form of RAM 
and a power supply unit come packaged in a microcomputer. These 
computers can fit on desks or tables and serve as the best choices for single- 
user tasks. 

 
Personal computers come in a variety of forms such as desktops, laptops and 
personal digital assistants. Let us look at each of these types of computers. 

 
Desktops: A desktop is intended to be used on a single location. The spare 
parts of a desktop computer are readily available at relative lower costs. 
Power consumption is not as critical as that in laptops. Desktops are widely 
popular for daily use in workplaces and households. 

Laptops: Similar in operation to desktops, laptop computers are 
miniaturized and optimized for mobile use. Laptops run on a single battery or 
an external adapter that charges the computer batteries. They are enabled 
with an inbuilt keyboard, touch pad acting as a mouse and a liquid crystal 
display. Its portability and capacity to operate on battery power have served 
as a boon for mobile users. 

 
Personal Digital Assistants (PDAs): It is a handheld computer and 
popularly known as a palmtop. It has a touch screen and a memory card for 
storage of data. PDAs can also be effectively used as portable audio players, 
web browsers and smart phones. Most of them can access the Internet by 
means of Bluetooth or Wi-Fi communication. 

 
Minicomputers: In terms of size and processing capacity, minicomputers lie 
in between mainframes and microcomputers. Minicomputers are also called 
mid-range systems or workstations. The term began to be popularly used in 
the 1960s to refer to relatively smaller third generation computers. They 
took up the space that would be needed for a refrigerator or two and used 
transistor and core memory technologies. The 12-bit PDP-8 minicomputer of 
the Digital Equipment Corporation was the first successful minicomputer. 
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Supercomputers: The highly calculation-intensive tasks can be effectively 
performed by means of supercomputers. Quantum physics, mechanics, 
weather forecasting, molecular theory are best studied by means of 
supercomputers. Their ability of parallel processing and their well-designed 
memory hierarchy give the supercomputers, large transaction processing 
powers. 

 

 
Wearable Computers: A record-setting step in the evolution of computers 
was the creation of wearable computers. These computers can be worn on 
the body and are often used in the study of behavior modeling and human 
health. Military and health professionals have incorporated wearable 
computers into their daily routine, as a part of such studies. When the users’ 
hands and sensory organs are engaged in other activities, wearable 
computers are of great help in tracking human actions. Wearable computers 
are consistently in operation as they do not have to be turned on and off and 
are constantly interacting with the user. 

 
These were some of the different types of computers available today. Looking 
at the rate of the advancement in technology, we can definitely look forward 
to many more types of computers in the near future. 



 

lOMoARcPSD|156 792 49  

 

 

 

Computer Hardware 

Learning Objectives: 

After reading this information sheet, YOU MUST be able to identify the 
computer hardware. 

Now that you know a little bit about the history of computers and how they 
are useful in various work situations throughout the world, this lesson will tell 
you what makes up today’s personal computer (PC). You learn about basic 
computer hardware and the importance of keeping your computer and its 
data safe. Next, you learn all about operating systems—the software that 
makes it possible for you to use your computer—with a focus on Microsoft 
Windows XP. Finally, you learn about applications software and how a 
computer network operates. 

1. Computer Hardware 

Computer Parts and Storage Devices 
Most computers on the market today have the following components: a 
processor, RAM, a monitor, a hard disk drive, a keyboard, a mouse, a CD- 
ROM drive, a sound card, and a modem. In addition, you might want or need 
components that aren’t part of your computer’s package, such as a DVD 
drive, Zip drive, printer, and scanner. The rest of this lesson explains what 
these components, usually called peripherals, are and how they are used. 

A Mouse 

Most computers come with a mouse. A mouse is just a pointing device for 
selecting items on the screen. Some designs are different, including the 
mouse with a small wheel with which you can do some added tricks. An 
alternative to the mouse is a track ball, a stationary cradle containing a ball 
that you roll with your fingertips. Laptop computers offer another alternative, 
the touchpad—a pressure-sensitive surface built into the keyboard console. It 
lets you move your cursor by tracing your finger on the touchpad itself. 

This mouse is designed to fit the shape of a human hand and contains a 
wheel for extra functionality. 

Keyboards 

The computer keyboard is one of the basic ways of entering information into 
the computer, so most computers have one except certain types of handheld 
devices. If you’ve used a typewriter, you can use a computer keyboard. 
Keyboards come in a variety of styles. The Microsoft keyboard shown below 
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has an ergonomic design that reduces the muscle and tendon strain in the 
wrists, arms, and elbows. 

The optimized keyboard helps reduce the stress on wrists, arms, and elbows. 

Monitors 

Monitors are a requirement, so they are often included as standard 
equipment, but not always. Today, monitors are available in all price ranges. 
Most people think the bigger the monitor, the better, as long as it fits within 
their allotted budget range. Granted, bigger is more expensive, but today a 
17-inch monitor doesn’t cost much more than a 15-inch monitor and the 
difference is more than worth it. The more screen space you have, the easier 
it is to work with your applications on the computer. Remember, however, 
that the bigger the display, the larger the tube. A larger tube takes up more 
room on your desk. (Many manufacturers do offer short-tube monitors that 
don’t eat up a lot of desktop real estate.) 

It’s not fancy, but this typical computer monitor is all you need. 

A good choice when your desk space is at a premium is the flat-panel 
display, or LCD monitor. An LCD is a tubeless monitor that uses a liquid 
crystal technology. These monitors require much less desk space, and the 
absence of a picture tube means lower power consumption and less heat 
thrown off in your room. The cost is higher than that of a traditional monitor, 
but the prices are coming down. 

Floppy Disk Drive 

This comes as standard with most computers. For many years, the floppy 
disk was the way to give someone a document from your machine. You 
copied the information to the floppy and passed the floppy on. Then came 
the Internet and networking, which are new and convenient ways to 
exchange information. Floppy drives are a common way of backing up files. 

CD Drive 

Almost all computers have CD drives as standard equipment. Most software 
today is shipped on CDs, as are all the essential learning programs, games, 
and reference tools such as Microsoft Encarta, an encyclopedia. A CD drive 
also allows you to use CDs (short for compact disc) with your computer. CD 
drives are rated by the speed at which they can access information on the 
CD, indicated with a number like 12x, 20x, 32x, or 40x, which is read as “40 
speed.” 

CD drives come in two types: read-only and recordable. With the read only 
model, you can’t save or store any of your own information on a normal CD. 
Such a CD drive is the computer equivalent of a stereo record that can also 
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hold text and graphics. Recordable CD drives allow you to copy information 
to them as you would to floppy disks. 

Sound Cards 

A sound card is like your stereo amplifier at home, although it does 
considerably more than that! Unless you open your computer, you won’t see 
your computer’s sound card, and if you don’t have one, you won’t be able to 
hear any of the sounds a computer is capable of generating. Most computers 
come equipped with sound cards. 

A description of a sound card can be confusing because it has so many 
incomprehensible-sounding features: MIDI libraries, MIDI interface, sampling 
capabilities, and audio playback rates. Despite the confusing jargon, you 
want a sound card that supports the latest standards and features if possible. 
When a PC is described as a multimedia PC, it will include a sound card. If 
you’re not buying a new computer or are simply upgrading your existing 
sound card, look for the most common features across the different brands. 

Speakers 

With a sound card, a CD drive, and speakers, you can play regular audio CDs 
on your computer and enjoy many of the other audio features of the 
applications on your computer. But as with your stereo, you can’t hear 
anything unless you have speakers! Most likely, your computer will come 
with speakers. Speakers come in all price ranges, but even the less 
expensive ones work well. The speakers plug into the back of your computer, 
and look similar to the ones shown below. 

With these speakers, you can hear music and other special audio, as well as 
the everyday reminders and warning sounds your computer makes. 

 

 
Hard Disk Drives—Closet Space for Your Computer Creations 

Today, a computer without a hard disk drive is practically unknown. The hard 
disk drive is a physical part of your computer where you save all your work 
for access at another time. For new users, the multi-gigabyte drives of today 
are more than adequate, but some users run out of disk space and need to 
expand their digital closet space with higher-capacity hard drives. Graphic 
artists and photographers, for example, can easily use 40 megabytes of disk 
space just for one image, and some programs require several hundred 
megabytes of free space to run. If you are going to be working with photos 
extensively, you might need a larger hard drive, or you might want to check 
out Zip drives, which are described in a later section. 
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RAM: Short-Term Memory You Can Buy 

All computers come with internal memory, called RAM (pronounced like the 
animal), which is short for random access memory. RAM is sometimes 
confused with hard disk storage, which is completely different. Your 
computer needs RAM to run programs. You don’t need to know the ins and 
outs right now, but if you are picking out a new PC, look for one that provides 
at least 128 megabytes of RAM to work effectively on the Internet. If your 
computer has less, it won’t operate as quickly, but as long as it has enough 
memory to run current software, your computer will still operate correctly. 
The minimum for current software is usually 64 megabytes. 

Zip Drives 

A Zip drive is the newer version of a floppy disk drive. Zip drives, sometimes 
built into new computers, use a Zip disk that is about twice as thick as a 
floppy disk and holds 100 megabytes of information (250 megabytes for the 
newest model)—about 80 times more than a standard floppy disk. A Zip 
drive is something to consider if you will be working with many photographs 
that take up a lot of disk space for each image. These drives also provide a 
convenient way to make backup copies of all the important files you want to 
keep. 

Modems 

Modems are now as ubiquitous as computers, and more often than not, they 
come built into computers. You must have a modem to connect to the 
Internet, so make sure that your computer has one. If you use telephone 
lines for Internet access, the typical speed for a home modem is 56 K. If your 
computer doesn’t have one already installed internally, you can obtain an 
external modem, which sits near your computer rather than inside it. 
External modems are widely available and require minimum installation. 

If you use cable or a dedicated line for Internet access, you will need a 
specialized modem. These are much faster than the modems designed to 
work with the telephone lines, but they are more expensive. 

Printers 

Hundreds of different printers are on the market, in a wide range of prices. 
Printer technology has advanced dramatically in the last 10 years, so even a 
less expensive printer can produce impressive results. Some new computer 
packages include a printer. Printers are easy to buy and easy to install if the 
computer you obtain doesn’t have one. 

Printers are distinguished by printing features, output quality, and speed— 
that is, how many pages they can print in a minute. The most popular 
printers for home use are ink jet printers. Ink jets print pages by spraying a 
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fine ink mist onto the page and are the type of printers most often used for 
color printing. Laser printers, although more expensive, are faster and of 
higher quality, and most models allow only black-and-white printing. Color 
laser printers can be quite expensive. You can also find multipurpose 
machines that print, fax, copy, and scan. If you have a need for all these 
features, check with a local computer store or current magazines to learn 
more about features and trade-offs. 

Laser Printers 

Laser printers, long the standard for professional and corporate users, are 
fast and efficient, and typically are much faster than ink jet printers. Some 
laser printers can print 32 ppm (pages per minute), which is blazingly fast. 
They also offer multiple trays for different paper sizes and a host of other 
features. If you have a small business that requires a good deal of printing or 
invoicing, or if you expect to use your printer for a community publishing 
system for a club or group, this type of printer will give you very fast results. 
However, unless you buy an expensive color laser, you are signing up for 
black-and-white printing only. 

Ink Jet Printers 
 

Ink jet printers are the home standard. They provide color capabilities as well 
as crisp black and white, but their speed doesn’t match that of laser printers. 
The cheaper models can take more than a minute to print a full page of text. 
But for most people, the benefits outweigh the inconvenience. 

Joysticks for the Future Racecar Driver or Pilot 

Computers have become phenomenal game stations, and certain hardware 
additions can make your playtime wildly enjoyable. You can find several 
different types of game controllers, including joysticks. As with all computer 
peripherals, prices vary widely, but a standard joystick is relatively 
inexpensive. Simple joysticks consist of a single post fixed at the base like a 
stick shift that can move in all directions. You have probably seen one on a 
motorized wheelchair to allow the driver to steer with minimal movement. If 
you are planning to “learn to fly” with Microsoft Flight Simulator, a joystick is 
required. 

This joystick gives you control when you play video games. 

Besides joysticks, you can even find steering wheels with dashboard 
consoles if you want to try your hand at a racecar game. The newest 
controllers include vibration; when something happens on-screen, the 
controller vibrates and you feel the jolts and motions of the game you are 
playing. 
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Now Playing: A Movie on Your DVD Drive 

Never mind the technical details: a DVD drive lets you watch full-length 
movies on your computer, and you don’t even have to rewind! If you are 
interested and if your computer is set up in a room to allow easy viewing, 
you can rent videos, not on videotape, but on the newest form of CD drives, 
the DVD. The DVD is the most recent generation of CD drives; a DVD disk 
can hold about six times as much information as a regular CD. 

CD and DVD Burner 

If you want to write your own CDs but your CD drive doesn't have writing 
capabilities, you might consider buying a specialized drive for this purpose. 
This kind of drive is called a CD burner. CD burners are quite inexpensive and 
easy to install. The more expensive DVD burners use the newer DVD format, 
which allows you to store more information on your disks. 

Scanners for Transferring Photos onto Your Computer 

A scanner is used to copy an image or page for storage and display on the 
computer. Scanners typically look like little copying machines, with a glass 
plate (the plate you put the copy on) and a heavy rubberized mat that lies on 
top of that. 

DVD drives still accept standard CD-ROM disks and audio CDs, so you don’t need a CD drive if 

you get a DVD drive. 

Use a scanner such as this one to move print pictures onto your computer. 

Scanners are great if you have many pictures that you want to preserve or 
share with others. Scanners are also great if you have a lot of typed text that 
you want to store on the computer. Scanners now come with OCR (optical 
character recognition) software that actually reads the text on the page and 
turns it into a text file. This doesn’t work very well with handwritten text, 
however, so if your intention is to use a scanner to translate your brother’s 
badly written letters into something legible, don’t count on it. 

Special Needs 

What happens when someone can’t use a standard keyboard or mouse? Or 
what if someone can’t read the screen well or hear the computer’s audio 
cues? Smaller companies have created a whole class of hardware for special 
needs. If you’re visually or hearing impaired, or suffer from arthritis or partial 
paralysis, some useful and well-conceived alternatives are available for you. 
Some special needs options are built into Windows, and there is a universe of 
hardware and software options available as well. 
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The range of options is almost as diverse as the range of special needs. To 
find the best software and hardware solution, ask your specialist or local 
gerontologist for more information. When you get on the Web, you’ll find a 
huge number of resources to choose from as well. 

Note 

Windows XP comes with Accessibility Options, which address many special 
computing needs. Visit http://www.microsoft.com/enable/products/ for details 
on how to access these features and for more information on other 
accessibility products. 

Other Attachments 

Besides all the things commonly attached to a computer, an impressive array 
of other attachments exists. Here are some of the things that might catch 
your eye. If it’s an electrical appliance, there’s a good chance that one model 
or another can connect to your computer. Here is a partial list: 

■  Some types of musical keyboards referred to as MIDI keyboards or 
MIDI compatible keyboards can be connected to your computer so that you 
can record a performance, edit it, and play it back. 

■  Robotics toys allow you to build a robot, program it on your PC, and 
then let it roam around your home executing your instructions. 

■  Digital video cameras can be attached to your computer, and you 
can transfer images to or from your computer. 

■  Digital cameras, which are cameras that take instant, filmless 
pictures, allow you to snap away and then transfer the pictures directly to 
your PC. 

■  Sewing machines connect to a personal computer and do 
extraordinary multicolored stitch work based on the orders you 
give it. 

http://www.microsoft.com/enable/products/
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Computer Storage Devices 

Learning Objectives: 

After reading this information sheet, YOU MUST be able to identify the 
different type’s computer storage devices. 

Knowing what kinds of storage devices are available can keep you from using 
up too much space on your computer’s hard drive. They can also help keep 
your computer’s hard drive from crashing, along with keeping it running at 
top speed. 

The most common storage devices are: 

· Floppy Disks 

· Zip Disks 

· CD + RW 

· CD + R 

· DVD + RW 

· DVD + R 

1. Storage Devices 
 

Floppy Disk – They are plastic square disks, usually with a silver or black 
sliding piece going across the top. These disks come in a variety of colors 
and they hold about 144 million bytes. (Bytes are characters, symbols and 
letters). 

Zip Disk – They look like a floppy disk, but they are a little thicker. This disk 
also comes in a variety of colors and holds about 200 MB of data. 

CD + RW Disc (Compact Disc Rewriteable) – This disc looks like a regular 
CD. The only difference is that you can write on this disc and erase it as 
many times as you want. It works just like a floppy disk or a zip disk. A CD + 
RW disc holds about 650 MB. 

c (Compact Disc Recordable) – This one is a CD that you can record on. It’s 
mostly used to record audio and once it’s been written on, you cannot 
rewrite or erase anything off of it. This compact disc comes in different sizes, 
but they are usually silver in color. (Some CDs are black in color and they 
actually don’t get as many scratches on them as the silver ones do. They are 
also a lot less fragile). 

A DVD – R Disc (Digital Video Recordable) – These discs hold the space of 
about 4.7 GB and are used to record movies on. 
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The more uncommon storage devices are: 

· Removable Hard Drive 

· Internet Hard Drive 

· Flash 

· PC Cards 

· Smart Cards 

· Storage Tapes 

· Memory Sticks 

· Smart Media 

Removable Hard Drive – This is a disk drive in which a plastic or metal 
case surrounds the hard drive. It can be inserted and removed just like a 
floppy disk. It holds about 2 GB of data. 

Internet Hard Drive – This one is a service on the Internet that provides 
storage space to computer users. This service offers about 25 MB of space, 
but it could be more, depending on the service type. 

Flash Drive – This a storage device that comes in many colors and has a 
stick shape to it. They are very small in size, but they can hold anywhere 
between 256 MB and 16 GB of material on them. 

 
PC Card – This is a thin credit card size device that fits into a PC card slot, 
usually on a notebook computer. This card simply adds storage to most 
notebooks. 

Smart Cards – These are the size of an ATM card. When inserted into a 
smart card reader, they can read and update data for you. 

Storage Tape – This one is a magnetically coated ribbon of plastic, capable 
of storing large amounts of data at a very low cost. Usually, storage tapes 
are a little bigger than audio tapes. Older computers used tape and tape 
drives, but even today, some people still back their systems up with storage 
tape. These tapes hold between 20 GB to about 110 GB of data. An external 
tape drive can be purchased separately as well, but those are even harder to 
find. 

Miniature Mobile Storage Media – This is used mostly with handheld 
computers and digital cameras. 
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Memory Stick – This is a rectangular shaped disk that is used mostly with 
digital cameras and notebook computers. They hold approximately 128 MB 
as well. 

Micro Drive – This is a square disk that has 1 GB of space and is used with 
digital cameras and handheld computers. 

Smart Media Disc – This is a square disk that has 2 MB to about 128 MB of 
space on it. It’s used with digital cameras, handheld computers and photo 
printers. 

There you go! These are just some of the storage devices that are available 
today. So, the next time you want to save something that takes up a large 
amount of space on your hard drive, think twice about it and consider using 
one of these storage devices instead. One of these devices could save you a 
lot of space on your hard drive and keep your system running at its best! 
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Major Types Of Software 

Learning Objectives: 

After reading this information sheet, YOU MUST be able to identify the 
different major types of software. 

 
 
 
1. Software 

 

Software is the means by which computer systems speak with computer 
users. Software forms the heart of computer systems. What are the major 
types of software? Read on to find out. 

 

 
Software, by definition, is the collection of computer programs, procedures 
and documentation that performs different tasks on a computer system. The 
term 'software' was first used by John Tukey in 1958. At the very basic level, 
computer software consists of a machine language that consists of groups of 
binary values, which specify processor instructions. The processor 
instructions change the state of computer hardware in a predefined 
sequence. Briefly, computer software is the language in which a computer 
speaks. There are different types of computer software. What are their major 
types? Let us see. 

 
Major Types of Software 

 
Programming Software: This is one of the most commonly known and 
popularly used forms of computer software. This software comes in forms of 
tools that assist a programmer in writing computer programs. Computer 
programs are sets of logical instructions that make a computer system 
perform certain tasks. The tools that help the programmers in instructing a 
computer system include text editors, compilers and interpreters. 

 
System Software: It helps in running the computer hardware and the 
computer system. System software is a collection of operating systems; 
devise drivers, servers, windowing systems and utilities. System software 
helps an application programmer in abstracting away from hardware, 
memory and other internal complexities of a computer. 

 

 
Application Software: It enables the end users to accomplish certain 
specific tasks. Business software, databases and educational software are 
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some forms of application software. Different word processors, which are 
dedicated for specialized tasks to be performed by the user, are other 
examples of application software. 

 
Apart from these three basic types of software, there are some other well- 
known forms of computer software like inventory management software, 
ERP, utility software, accounting software and others. Take a look at some of 
them. 

 
Inventory Management Software: This type of software helps an 
organization in tracking its goods and materials on the basis of quality as 
well as quantity. Warehouse inventory management functions encompass the 
internal warehouse movements and storage. Inventory software helps a 
company in organizing inventory and optimizing the flow of goods in the 
organization, thus leading to an improved customer service. 

 
Utility Software: Also known as service routine, utility software helps in the 
management of computer hardware and application software. It performs a 
small range of tasks. Disk defragmenters, systems utilities and virus 
scanners are some of the typical examples of utility software. 

 
Data Backup and Recovery Software: Ideal data backup and recovery 
software provides functionalities beyond simple copying of data files. This 
software often supports user needs of specifying what is to be backed up and 
when. Backup and recovery software preserve the original organization of 
files and allow an easy retrieval of the backed up data. 

 
This was an overview of the major types of software. Computer software are 
widely popular today and hence we cannot imagine a world of computers 
without them. We would not have been able to use computers if not for the 
software. What is fascinating about the world of computers is that it has its 
own languages, its ways of communication with our human world and human 
interaction with the computers is possible, thanks to computer software. I 
wonder, if the word 'soft' in ‘software’ implies ‘soft-spokenness’, which is an 
important quality of a pleasant communication 
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OPERATING SYSTEM 

Learning Objectives: 

After reading this information sheet, YOU MUST be able to identify the 
operating systems. 

 
 
 
1. Operating system 

 

An operating system (OS) is software, consisting of programs and data, 
that runs on computers, manages computer hardware resources, and 
provides common services for execution of various application software. The 
operating system is the most important type of system software in a 
computer system. Without an operating system, a user cannot run an 
application program on their computer, unless the application program is self 
booting. 

For hardware functions such as input and output and memory allocation, the 
operating system acts as an intermediary between application programs and 
the computer hardware,[1][2]   although the application code is usually executed 

directly by the hardware and will frequently call the OS or be interrupted by 
it. Operating systems are found on almost any device that contains a 
computer—from cellular phones and video to supercomputers and web 
servers. 

Examples of popular modern operating systems are: BSD, Linux, Mac OS 
X, Microsoft Windows, and Unix.[3]

 

 

 

Types 

Real-time 

A real-time operating system is a multitasking operating system that aims at 
executing real-time applications. Real-time operating systems often use 
specialized scheduling algorithms so that they can achieve a deterministic 
nature of behavior. The main objective of real-time operating systems is their 
quick and predictable response to events. They have an event-driven or 
time-sharing design and often aspects of both. An event-driven system 
switches between tasks based on their priorities or external events while 
time-sharing operating systems switch tasks based on clock interrupts. 

Multi-user vs. Single-user 
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A multi-user operating system allows multiple users to access a computer 
system concurrently. Time-sharing system can be classified as multi-user 
systems as they enable a multiple user access to a computer through the 
sharing of time. Single-user operating systems, as opposed to a multi-user 
operating system, are usable by a single user at a time. Being able to have 
multiple accounts on a Windows operating system does not make it a multi- 
user system. Rather, only the network administrator is the real user. But for a 
Unix-like operating system, it is possible for two users to login at a time and 
this capability of the OS makes it a multi-user operating system. 

Multi-tasking vs. Single-tasking 

When a single program is allowed to run at a time, the system is grouped 
under a single-tasking system, while in case the operating system allows the 
execution of multiple tasks at one time, it is classified as a multi-tasking 
operating system. Multi-tasking can be of two types namely, pre-emptive or 
co-operative. In pre-emptive multitasking, the operating system slices the 
CPU time and dedicates one slot to each of the programs. Unix-like operating 
systems such as Solaris and Linux support pre-emptive multitasking. 
Cooperative multitasking is achieved by relying on each process to give time 
to the other processes in a defined manner. MS Windows prior to Windows 95 
used to support cooperative multitasking. 

Distributed 

A distributed operating system manages a group of independent computers 
and makes them appear to be a single computer. The development of 
networked computers that could be linked and communicate with each other, 
gave rise to distributed computing. Distributed computations are carried out 
on more than one machine. When computers in a group work in cooperation, 
they make a distributed system. 

Embedded 

Embedded operating systems are designed to be used in embedded 
computer systems. They are designed to operate on small machines like 
PDAs with less autonomy. They are able to operate with a limited number of 
resources. They are very compact and extremely efficient by design. 
Windows CE and Minix 3 are some examples of embedded operating 
systems. 
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Customizing Windows Desktop 

Learning Objectives: 

After reading this information sheet, YOU MUST be able to customize 
windows desktop. 

 
 
 
1. Customizing Windows Desktop 

 

Start menu 

 

 
The Start menu is a primary conduit to functions and files. How to configure 
it for individual preferences is discussed. 

Many of the properties of the Start menu can be configured by right-clicking 
the Start button and choosing "Properties" from the context menu. Figure 1 
shows the resulting properties sheet. To customize the Start menu, click the 
"Customize" button. This will open the dialog box shown in Figure 2. Those 
who wish can change the appearance of the Start menu to the older look by 
choosing "Classic Start menu". Only the XP style will be considered in this 
discussion. 

 
 

 
There are several areas in the Windows XP Start menu and these are shown 
in figure 3. A number of the entries are discussed in following sections. 

Recently used programs 
 

Using an algorithm that is not always clear, Windows XP will place shortcuts 
to some of the programs that you have recently used into the area labeled 
“Recently used programs”. 

 

 
Pinned programs 

If you wish to give a permanent place on the Start menu to a favorite 
program, place it in the “Pinned” area. Right-click the program entry in the 
All Programs menu or other location and choose “Pin to Start menu”. To 
remove a program from the pinned area, right-click and choose “Unpin from 
Start menu”. 
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Organizing the “All Programs” menu 
 

The listings in the All Programs menu are just shortcuts to the actual 
program files and can be edited like any other shortcut. 

Customizing Shortcuts 

 

 
One way to use Windows XP better and more efficiently is to have a quick path to your most 

common tasks. Here's how to create useful shortcuts. 

Everyone is familiar with the icons placed on the desktop, the shortcuts to open programs. Many 

are also aware that shortcuts can be placed in the taskbar. However, the average PC user is often 

unfamiliar with the various methods that exist for creating shortcuts, not just to programs but 

also for other functions. There are a number of methods for creating new shortcuts: 

 

• Drag and drop 
• The right-click “Send To” function 

• The right-click “New” function 
 

A discussion of each approach to creating shortcuts is given in the sections below. 

Drag and drop 
 

The drag and drop method can be used in several ways. Either the left or the right mouse button 

can be used for drag and drop with somewhat different behavior. I prefer the right-click method 

and this will be the basis for the rest of the discussion. Dragging with the right-click brings up 

the context menu shown in the figure. One way to employ drag and drop is to use the menu entry 

"Copy Here" to make a copy of an existing shortcut in a different location. For example, an entry 

in the Start-All Programs menu can be dragged to the desktop or to the Quick Launch bar to 

place a copy of a shortcut in a more readily available spot. 

 

 
The right-click “Send To” function 

 

For making shortcuts specifically on the desktop, the Send To function of the right-click can be 

used (figure on the left). Simply right-click on the desired file or folder and select "Desktop 

(create shortcut)" from the "Send To" menu. 

The right-click “New” function 
 

The most general method for creating shortcuts uses the "New" function of the context menu that 

appears when a vacant spot within a folder window or on the desktop is right-clicked (figure on 

the left). Right-click in the folder where the shortcut is to be placed and select the entry 

"Shortcut" from the menu. The dialog box shown below will open. The location of the target 

item can be entered or the "Browse" function can be used to locate it. 

First dialog box for creating new shortcut 
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If the "Browse" button is selected, the dialog shown below will open. Here you can select the file 

or folder that you wish to create a shortcut for (the target). Once the desired folder or file has 

been selected, Click the "OK" button. 

Dialog box for Browse function 

 

 
Customizing the Taskbar 

The Taskbar is the strip across the length of the screen that is the central means for accessing 

programs and files. Configuring it to suit individual preferences is discussed. 

Windows XP taskbar 

Configuring the taskbar 
 

To configure the taskbar, right-click in an empty space on the bar and select “Properties” from 

the context menu. The resulting dialog box is shown in the figure below. 

Taskbar properties sheet 
 

Notification Area (aka System Tray) 
 

A variety of programs will place icons in the section of the taskbar on the far right that typically 

contains the clock. In XP, Microsoft calls this the “Notification area”. It was previously known as 

the “System tray”. 

Section of Taskbar properties for Notification area 

 

 
Toolbars 

 

It is possible to add customized toolbars to the middle area of the taskbar. Right-click an empty 

spot on the taskbar and choose “Toolbars”. There are five standard default choices, including 

“Quick Launch” (first figure below). (Other software may sometimes add extra choices.) There is 

also an item “New toolbar” that allows the choice of any folder (second figure below). The 

Desktop toolbar gives access to the contents of the desktop without having to minimize any open 

windows. Similarly, a frequently used folder can be made easily accessible by creating a toolbar 

for it. 

 

 

TO CHANGE YOUR DESKTOP 

BACKGROUND 
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1. Open Display in Control Panel. 

2. On the Desktop tab, do one or more of the following: 

• Click a picture in the Background list. In Position, click Center, Tile, or Stretch. 

• Click Browse to search for a background picture in other folders or on other drives. You can use 

files with the following extensions: .bmp, .gif, .jpg, .dib, .png, .htm. In Position, 

click Center, Tile, or Stretch. 

• Select a color from Desktop color. The color fills the space not used by a picture. 

Note 

•To open Display, click Start, click Control Panel, click Appearance and Themes, and then 

click Display. 

•You can use a personal picture as a background. All of your personal pictures located in My 

Pictures are listed by name in the Background list. 

•You can save a picture from a Web site as a background. Right-click the picture and then click Set 

as Background. The picture is listed in the Background box as Internet Explorer Background. 

•If you choose an .htm document as your background picture, the Position options are unavailable. 

The .htm document is automatically stretched to fill your background. 

 

 
Screen Saver 

A screensaver is a computer program originally designed to conserve the image quality 

of computer displays by blanking the screen, or filling it with moving images or patterns when 

the computer was not in use. Today, screensavers are primarily used for entertainment or security 

purposes. 

Steps: 

 
1. Open Display properties by Clicking Start, Control Panel & Display or Right Click your desktop and 

choose properties. 
2. Click Screen Saver Tab 

3. Choose your screen saver and click applies. 
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Getting Started with Word 

After completing this lesson, you will be able to: 

Start Word. 
 

• Explore the Word window. 
• Enter text in a document. 
• Save a document. 

• Close a document and quit Word. 

 

 

 
1. Getting Started with Word 

 

Just a few years ago, correspondence was created with paper and pencils, 
pens, or typewriters. Gone are the days, however, of correction fluid, 
crossed-out words, and wads of crumpled papers scattered around your 
garbage can. Today most personal and professional correspondence is 
created using computers. And, in most cases, those computers are running a 
word-processing program to make the creation of documents easier and 
more accurate. 

Microsoft Word is one such word-processing program. With the help of 
Microsoft Word, you can quickly and easily create memos, faxes, reports, 
letters, charts, and newsletters. You can also, among other things, add 
graphics to documents and use other Microsoft Office XP programs to import 
data into a Word document. Not only is Word a convenient time-saver, but 
Word also allows you to check spelling and edit documents before printing. 
No longer do reports, letters, and other documents have to be completely 
retyped just because of an error or two. Word allows you to edit quickly and 
leaves you with a very clean, professional-looking document (and saves you 
from emptying your garbage can so often). 

In this lesson, you will learn how to start and quit Word and how to identify 
the various components in the Word window, such as the menu bar 
and toolbar. You’ll explore the task pane, you’ll practice entering text into a 
document, and then you’ll save a document. To complete the procedures in 
this lesson, you will create your own practice files. 

 

 
 

A toolbar is a group of buttons used to carry out commands. For example, the Drawing toolbar 

contains buttons that you can use to draw and format pictures. 

The taskbar is the strip along the bottom or side of the screen. You use the mouse pointer to open 
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applications on the taskbar. 

 

 

 

 

 

 

 

 

Starting Word 
You start Word by clicking the Start button, which is at the left end (or top) of 
the Microsoft Windows taskbar. After you start Word, the program appears 
in its own window with a new, blank document open. A window is an area 
of the screen that is used to display a program or document. Every window 
has common components, including scroll bars and toolbars. You’ll learn 
more about the components of the Word window later in this lesson. A 
document is a self-contained piece of work created by using a program. 

In other words, the Word window and each open document are displayed in 
separate windows. You can use Word to open multiple documents (therefore 
multiple document windows) at a time, you can resize a document window, 
and you can also minimize a document window. When you minimize a 
document window, the document window is reduced to a button on the 
Windows taskbar. The document is still open; you just can’t see it. 

Notice in this illustration that the Standard and Formatting toolbars are on separate lines to allow 

you to view them clearly. 

 

 

 
 

In this exercise, you use the Start button to open Word. 

1 Click the Start button at the left end (or top) of the Windows taskbar, 
which is typically located along the bottom of the screen. (You may also find 
it at the top or along one of the sides of the screen.) 

The Start menu appears. 

2 On the Start menu, point to All Programs. 

The All Programs submenu appears. 

3 On the All Programs submenu, click Microsoft Word. 
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Word starts. 

 
 

 
tip 

Rather than clicking the Start button, pointing to All Programs, and clicking 
the program that you want to use, you can save time by creating a desktop 
shortcut. You simply double-click a shortcut icon to start its associated 
program. To create a desktop shortcut to Word, click the Start button, point 
to All Programs, point to Microsoft Word, and hold down the Ctrl key while 
you drag the Microsoft Word icon to the desktop. Double-click the Word 
shortcut icon to open Word. 

 

 
 

Exploring the Word Window 
Many components in the Word window are similar to those in other Windows 
programs. The following illustration displays the elements in the Word 
window, and a description of each element follows the figure. 

A desktop shortcut is represented by an icon with a curved arrow in the left corner. You can 

create a shortcut by right-clicking the desired button-icon and clicking Create Shortcut. The 

shortcut icon can be moved to the desktop by dragging the icon to the desktop. 

 

 

 

 
Title bar The area of a window or dialog box that displays the name of the 
current dialog box or application and the name of the current document. It is 
located along the top of the window. 

Menu bar The area that lists the names of the menus available in Word. 
A menu is a collection of related commands from which you can make a 
selection. The menu bar is located just below the title bar. 

Standard toolbar A toolbar that provides quick access to the editing 
functions you use frequently. For example, on the Standard toolbar, 
the button that you use to save a document contains an icon of a floppy 
disk. The Standard toolbar is located just below the menu bar. 
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Formatting toolbar A toolbar that provides quick access to the formatting 
functions that you use frequently. The names of buttons are displayed 
in ScreenTips when you position the mouse pointer over the buttons. 

 
 
Insertion point A blinking vertical line in the document window that 
indicates where the next character (any single letter, number, space, tab, 
page break, paragraph mark, or symbol that can be entered in a document) 
typed from the keyboard will appear. 

 

 
Selection area The area between the left edge of the window and the left 
edge of a line of text. You position the mouse pointer in the selection area to 
select an entire line of text. The pointer changes to a right-pointing arrow 
when it is positioned in the selection area. 

 

 
Ruler An on-screen scale marked with inches or other units of measure, 
which changes the indentation of paragraphs, resets a page margin (an area 
of blank space between the edge of the paper and the text), and adjusts the 
width of columns. The ruler is located below the toolbars. 

 

 
Scroll bars Bars that are used for moving the view of the document. The 
vertical scroll bar is located along the right side of the window, and the 
horizontal scroll bar is located along the lower portion of the window, just 
above the status bar. 

 

 
Navigation buttons Buttons that are used for moving the view in a long 
document. These buttons are located on the vertical scroll bar. 

 

 
Status bar A bar that displays explanations of currently selected text at the 
bottom edge of the program window. 

 

 
Minimize button A button that reduces a window to a button on the 
Windows taskbar. It appears as a button with a horizontal line and is located 
in the group of three buttons at the upper-right corner of the window. 
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Maximize/Restore Down button  A button that switches back and forth, 
or toggles (alternately turns an option on or off each time that the option is 
selected) between displaying a window in its maximum size and restoring a 
window to its previous size. It is located in the group of three buttons at the 
upper-right corner of the window. 

 

 
Close button A button that closes the current window or application. It is 
located in the group of three buttons at the upper-right corner of the window. 

 

 
ScreenTip A help item that shows the name of a button or screen element 
when you rest the mouse pointer on a toolbar button or screen element. 

 

 

 
Task pane Word organizes commands for common tasks in the task pane, a 
small window next to your document that opens when you need it. For 
example, when you start Word, you see the New Document task pane, which 
includes commands for opening and creating documents. Use the New 
Document task pane to open a saved or blank document, to create a 
document based on an existing one, or to create a document from 
a template (a file containing structure and style settings that help you 
create a specific type of document, such as a memo or resume). You can also 
show or hide any task pane when you like. If you want to use a task pane and 
the one that you want does not appear, you can manually show the task 
pane and then select the specific task pane that you want from the Other 
Task Panes menu on the task pane. If you no longer need the task pane, you 
can hide it to free up valuable screen space in the program window. On the 
View menu, click Task Pane; clicking the command hides the task pane if it is 
currently displayed or shows it if it is currently hidden. 

tip 

The task pane opens each time you start Word and closes when you open a 
document. If you don’t want the task pane to appear each time you start 
Word, clear the Show at Startup check box in the task pane. 

 
 

Entering Text 
You begin creating a document by simply typing text. When you enter text 
into a document, you don’t have to press Enter at the end of each line. 
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Word’s word wrap automatically wraps text from one line to the next each 
time the insertion point reaches the right margin. Word wrap breaks lines of 
text so that they stay within margin boundaries; you don’t have to enter hard 
returns. You press Enter only when you want to begin a new paragraph or 
insert a blank line. Word uses left and right page margins of 1.25 inches and 
top and bottom margins of 1 inch by default; however, you can reset the 
page margins. 

As you type text, the insertion point moves, indicating the location for the 
next character. If you make a mistake, press Backspace to delete characters 
to the left of the insertion point or press Delete to delete characters to the 
right of the insertion point. 

 
 

Saving a Document 
The text that you enter is stored in the computer’s memory, which is 
temporary. To keep the file for future use, you must store the document on 
your hard disk. 

In this exercise, you save your new document to your hard disk and save the 
document again after you make changes. 

1 On the Standard toolbar, click the Save button to display the Save As 
dialog box. 

 
 
2 In the File name box, type Brochure 01. 

3 Click the Save In down arrow, and click the icon for your hard disk. 

4 Double-click the Computer Fundamentals Practice folder. 

The Save in box displays the text Computer Fundamentals Practice, and the 
dialog box displays the contents of the Computer Fundamentals Practice 
folder. 

5 Double-click the Part III folder, and then the Lesson01 folder. 

The Lesson01 folder opens. 

6 Click the Save button. 

The file is saved to your hard disk with the new name, which is now 
displayed in the Microsoft Word title bar. 
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7 Click at the end of the first paragraph to position the insertion point 
there. 

8 Press the Spacebar, and type the following sentence: 

Meetings are held monthly where an expert guest speaker presents 
timely and pertinent information. 

9 On the Standard toolbar, click the Save button. 

Word saves the document. 

Keep this file open for the next exercise. 

Tip 

Word saves documents for recovery in case the program stops responding or 
you lose power. The Document Recovery task pane lists all recovered 
documents and allows you to open the documents, view the repairs, and 
compare the recovered versions. Word saves the changes in a recovery file 
based on the amount of time indicated in the AutoRecover option. To turn on 
the AutoRecover option and specify a time interval in which to save, on the 
Tools menu, click Options, click the Save tab, select the Save AutoRecover 
info every check box, specify the period of time, and then click OK. 

 

 
 

Closing a Document 
and Quitting Word 
After a file is stored on your hard disk, you can clear it from the screen by 
closing the document window or quitting Word. If the document has not been 
saved, Word prompts you to save the file before closing the window. 

To clear a document from the document window, on the File menu, click 
Close, or in the upper-right corner of the screen, click the Close button. 
Closing the current document window leaves Word still running. When you 
click Exit on the File menu, the Word program quits. 

1 On the File menu, click Close. 

The document closes, leaving Word open but no documents open. 

2 On the File menu, click Exit. 

Word closes. 
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3 To restart Word, Click the Start button on the Windows taskbar, point to 
All Programs, and click Microsoft Word. (You could also choose Microsoft Word 
from the first column of the Start menu.) 

Word starts. 

4 Click the Close button on the New Document task pane. 

Keep the new Word document open for the next exercise. 

 
To close MS Word Window 

1 On the File menu, click Close to close the file. If you are prompted to save 
changes, click No. 

Word closes the file without saving the changes. 

2 In the upper-right corner of the Word window, click the Close button. 

The Word program closes. 
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Learning Worksheet Fundamentals 

Learning Objectives: 
 

After completing this lesson, you will be able to: 

 
• Create a workbook. 
• Understand Microsoft Excel window elements. 
• Select cells. 
• Enter text, numbers, and dates in a worksheet. 
• Enter a range of data. 
• Edit cell contents. 
• Move between worksheets. 
• Name and save a workbook. 
• Open a workbook. 

• Close a workbook and quit Excel. 

 

 

 
1. Learning Worksheet Fundamentals 

 

Microsoft Excel is an excellent program for organizing, formatting, and 
calculating numeric data. Excel displays data in a row-and-column format, 
with gridlines between the rows and columns, similar to accounting ledger 
books or graph paper. Consequently, Excel is well suited for working with 
numeric data for accounting, scientific research, statistical recording, and 
any other situation that can benefit from organizing data in a table-like 
format. Teachers often record student grade information in Excel, and 
managers often store lists of data—such as inventory records or personnel 
records—in Excel. As you work through this course, you’ll learn how Excel 
makes it easy to perform calculations on numeric data and provides dozens 
of ways to format data for presentation purposes, including charts and 
reports. 

 

 
 

Creating a Workbook 

 
You start Excel by using any of the methods that you use to start other 
Microsoft Windows programs. 
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1 On the Windows taskbar, click the Start button, point to All Programs, 
and click Microsoft Excel. 

Excel opens with Book1 ready for you to use. 

 

 
2 In the New section of the New Workbook task pane, click Blank 
Workbook. 

Excel creates a workbook called Book2 and the task pane disappears. 

3 On the File menu, click Close. 

Excel closes Book2, and Book1 reappears. 

Keep this file open for the next exercise. 

 

Understanding Window Elements 
Many elements in the Excel window are similar to those in windows of other 
Windows programs. The graphic on the following page points out the most 
important parts of Excel, the last two of which were new in Excel 2002: the 
workbook window, the main menu bar, the formula bar, the Standard and 
Formatting toolbars, the Ask A Question box, and the task pane. 

 
 
The following table describes the elements in the Excel window. 

 

Element Description 

Title bar Identifies the current program and the name of the current 

workbook. 

Menu bar Lists the names of the menus in Excel. 

Toolbars Give you quick access to functions that you use frequently, such 

as formatting, aligning, and totaling cell entries. The Standard 

and Formatting toolbars appear by default. 

Name Box Displays the address of the active cell. 

Formula Bar Displays the contents of the active cell. 

Task pane Lets you open files, paste data from the Clipboard, create blank 

workbooks, and create Excel workbooks based on existing files. 
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Ask A Question box Displays the help topics that match your request, when you type 

a question in the box. 

Status bar Displays information about a selected command. It also indicates 

the status (on or off) of the Caps Lock and Num Lock keys. 

Scroll bars Include a vertical and a horizontal scroll bar and four scroll 

arrows, each of which is used to display different areas of the 

worksheet. 

Select All button Selects every cell in a worksheet. 

Sheet tabs Let you display worksheets in the open workbook. 

Worksheet A grid of vertical columns (identified by alphabetic characters) 

and horizontal rows (identified by numeric digits). Columns and 

rows intersect to form cells. Each cell can be identified by a full- 

cell reference, or address, consisting of the column and row 

coordinates of that cell—for example, B3. 

Active cell The cell, designated by a thick border, which will be affected 

when you type or edit data. 

Minimize button Minimizes the window to a button on the taskbar. 

Maximize/Restore Down 

button 

Toggles (switches back and forth) between maximizing a 

window and restoring a window to its previous size. 

Close button Closes the window on which the button appears. 

ScreenTip A small pop-up box that displays the name of an object or toolbar 

button if you point to it with the mouse pointer. 

 

Work with Excel window elements. 

1 Point to the Chart Wizard button on the Standard toolbar for a few 
seconds. 

A ScreenTip appears, displaying the words Chart Wizard. 

2 Point to the Name Box, which contains the cell address A1. 

A ScreenTip appears, displaying the title Name Box. 

 
3 Click the Toolbar Options button at the end of the Formatting toolbar. 
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A menu with options appears. 

 
 
4 Point to the Add or Remove Buttons command. 

A menu with additional commands appears. 

 
5 Point to Formatting on the submenu. 

A menu with the formatting button options appears. 

6 Position your mouse pointer over each newly displayed toolbar button. 

A ScreenTip appears to explain each button. 

7 When you are done, click somewhere outside of the open menus to close 
the menus. 

Keep this file open for the next exercise. 

 

 
 

Selecting Cells 
Before you can enter data into a worksheet, you must identify the cell (the 
intersection of a row and a column) in which you want to put the data. This is 
known as selecting the cell. You can select a single cell, a row, a column, 
and groups of adjacent and nonadjacent cells. 

To select a single cell, simply click that cell. When a cell is selected, a black 
border surrounds it, and that cell becomes the active cell, as shown in the 
following illustration. 

 

 
You can select all of the cells in a worksheet by clicking the Select All button 
at the top-left corner of the worksheet. 

 

 
You can select a single row or column in a worksheet by clicking the 
corresponding row or column selector. 

 

 
In this exercise, you select an entire row and an entire column in the current 
worksheet. 
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1 Click the column selector for column D. 

Column D is selected. 

2 Click the row selector for row 1. 

Row 1 is selected. 

3 Click the column selector for column B, and drag the mouse pointer to 
the column selector for column E. 

The columns are selected. 

4 Click any cell in column G. 

Columns B, C, D, and E are deselected. 

Keep this file open for the next exercise. 

 
 

 

Selecting a Range of Cells 
A range is normally identified by the references for its first and last cells 
with a colon between them. For example, the vertical range extending from 
cell A1 to cell A9 is identified as A1:A9. Likewise, the horizontal range 
extending from cell C3 to cell G3 is identified as C3:G3. Ranges that extend 
across a block of columns and rows are identified by the addresses for the 
cells in the top-left and bottom-right corners of that block (C5:F9), as shown 
in the following illustration. 

 

 
You select a range of cells by dragging the mouse pointer over the cells. 
When you select a range of cells, the first cell chosen becomes the active 
cell. The active cell is white, and the range of cells is blue. 

In this exercise, you select a group of adjacent cells in the current worksheet. 

1 Click cell E3, hold down the mouse button, drag the mouse pointer down 
to cell E12, and release the mouse button. 

The range E3:E12 is selected, and E3 remains the active cell. 

 
 
2 Click cell A5, hold down the Shift key, and click cell H16. 

The range is selected, and A5 remains the active cell. 
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3 Click cell F17, hold down the Shift key, and press the Down arrow key 
four times. 

The range of cells from F17 to F21 (referred to as F17:F21) is selected. 

 
 
 

Entering Text in a Worksheet 
In this exercise, you enter text in a worksheet. 

1 Click cell A1, type Sales, and press Enter. 

The text is entered into cell A1, and A2 becomes the active cell. 

2 Click cell A3, type Cabins, and press Enter. 

Cell A3 contains the word Cabins, and the active cell moves to A4. 

 
 
3 Type Condos, and press Enter. 

The word Condos is entered into cell A4. 

 
 
Keep this file open for the next exercise. 

 
 
 

Entering Numbers in a Worksheet 
A numeric entry contains some combination of the digits 0 through 9 and, 
optionally, the following special characters. 

 

Character Used To 

+ Indicate a positive value 

- or ( ) Indicate a negative value 

$ Indicate a currency value 

% Indicate a percentage 



 

lOMoARcPSD|156 792 49  

 

 

 

 

/ Indicate a fraction 

. Indicate a decimal value 

, Separate the digits of the entry 

E or e Display the entry in scientific (exponential) 

notation 

If you start an entry with a plus sign to indicate a positive number, Excel 
ignores the sign. If you type parentheses to indicate a negative number, the 
number appears with a minus sign. If you include a dollar sign, a percent 
sign, a forward slash, a comma, or an exponential symbol, the program 
automatically assigns a numeric format to the entry. 

By default, a numeric entry appears right-justified in a cell. If the entry is 
longer than the defined width of the cell, it appears in scientific notation, as 
pound signs (####), or rounded. Internally, however, Excel stores all 
numbers as originally entered. 

In this exercise, you enter sales figures in your worksheet. 

1 Click cell B3, type 42848, and press Enter. 

The number is entered in cell B3, and B4 becomes the active cell. 

2 Type 92346, and press Enter. 

The number is entered in cell B4, and B5 becomes the active cell. 

Keep this file open for the next exercise. 

 

Entering Dates in a Worksheet 

 
Dates in Excel worksheets can be represented using only numbers or a 
combination of text and numbers. For example, January 22, 2004, and 
1/22/04 are two ways of entering the same date. Like text, dates are often 
used as row and column labels. But unlike text, dates are considered serial 
numbers; they are sequential and can be added, subtracted, and used in 
calculations. 

 
 
In this exercise, you enter dates in a worksheet. 
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1 Click cell B1, type January 2004, and press Tab. 

Excel abbreviates the date to Jan-04, and C1 becomes the active cell. 

2 Type Feb 2004, and press Tab. 

Excel uses the same date formatting as above, and Feb-04 is entered in cell 
C1. D1 is now the active cell. 

Keep this file open for the next exercise. 

 
 
 

Entering a Range of Data 
To enter data in an individual cell, you type the data, and then press Enter. 
When you have several consecutive entries to make, you can select the 
range first to enter the data more quickly. 

In this exercise, you enter more sales figures in your worksheet. 

1 Click cell C3, drag to cell D4, and release the mouse button. 

Cells C3, C4, D3, and D4 are selected. 

 
2 Type 39768, and press Enter. 

The number is entered into cell C3, and C4 becomes the active cell. 

3 Type 90426, and press Enter. 

The number is entered into cell C4, and D3 becomes the active cell. 

4 Type 45122, and press Enter. 

The number is entered into cell D3, and D4 becomes the active cell. 

 
 
5 Type 87409, and press Enter. 

The number is entered, and cell C3 becomes the active cell. 

Keep this file open for the next exercise. 
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Editing Cell Contents 
In this exercise, you revise some of the entries in the current worksheet. 

1 Click cell B3, position the mouse pointer between 2 and 8 in the Formula 
bar, and click. 

Edit mode is activated, and the insertion point appears as an 
I-beam. 

2 Press Backspace, type 6, and press Enter. 

Cell B3 now contains the entry 46848. 

3 Click cell C4, type 92313, and press Enter. 

Cell C4 now contains the entry 92313. 

4 Click cell C3, type 65452, and click the Cancel button on the Formula 
bar. 

The data entry is cancelled and the original value is restored. 

Keep this file open for the next exercise. 

 

Moving Between Worksheets 
As explained at the beginning of this lesson, each Excel workbook is made up 
of individual worksheets. This gives you the flexibility to group worksheets 
with similar subject matter together in one workbook. 

 
 
In this exercise, you view two worksheets within the same workbook. 

1 Click the Sheet2 tab at the bottom of the workbook window. 

Sheet2 and its contents appear. The worksheet is blank. 

2 Click the Sheet1 tab at the bottom of the workbook window. 

Sheet1 and its contents reappear. 

Keep this file open for the next exercise. 
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Naming and Saving a Workbook 
When you finish entering and editing data in a workbook, you need to name 
and save the workbook on your hard disk so that the information will be 
available the next time you start your computer. 

As with any other Windows file, a workbook’s name can be up to 255 
characters long, but it can’t contain any of the following characters: 

/ \ > < * ? “ | : ; 

 

 
You can also use the controls in the Save As dialog box to specify a different 
format for the new file. 

. You also save the workbook as a Lotus file. (Lotus is another spreadsheet 
program.) 

1 On the File menu, click Save As. 

Excel displays the Save As dialog box. The files and folders that appear in 
this dialog box will depend on the folder that was last used to save a 
workbook on your computer. 

 

 
2 Click the Save In down arrow, and click the icon for your local hard disk 
(probably drive C). 

3 Double-click the Computer Fundamentals Practice folder. 

4 Click the Create New Folder button in the dialog box. 

The New Folder dialog box appears. 

5 Type 2004 Sales, and click OK. 

The New Folder dialog box closes and the Save As dialog box displays the 
2004 Sales folder. The name Book1 appears in the File name text box 
because Book1 is the open file. 

6 Select the text in the File name text box, type Lodging Sales, and then 
click Save. 

The file is named and saved. 

7 On the file menu, click Save As. 
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8 In the Save As dialog box, click the down arrow in the Save as type text 
box. 

9 Scroll and select the WK4(1-2-3)(*.wk4) option. 

10 Click Save. 

Your file is now saved with the same name but as a Lotus spreadsheet so it 
has a different file name extension. 

11 Close the workbook, but leave Excel open. 

 
 

Opening a Workbook 
After you save an Excel workbook, you can reopen it at any time to review its 
contents and make changes. 

1 On the Standard toolbar, click the Open button. 

The Open dialog box appears. 

2 Click the Look in down arrow, click the icon for your hard disk, and 
double-click the Computer Fundamentals Practice folder. 

The contents of the Computer Fundamentals Practice folder appear in the 
Open dialog box. 

 
 
3 Double-click the Part IV folder, then the Lesson01 folder. 

The names of the files stored in the Lesson01 folder appear. 

4 Click the Employee Information file, and click Open. 

The Open dialog box closes and the Employee Information file appears. 

5 On the File menu, click Close. 

Excel closes the Employee Information workbook. 

6 Click File on the menu bar. 

Excel displays a list of recently opened workbooks at the bottom of the File 
menu. 

7 On the File menu, click Employee Information. 
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The file opens. 

Keep this file open for the next exercise. 

 

 
 

Renaming a Worksheet 
By default, the worksheets in each Excel workbook are named Sheet1, 
Sheet2, and Sheet3. Just as giving a unique name to your workbook helps 
you remember what is in it, renaming a worksheet can remind you of its 
contents. 

In this exercise, you give a worksheet a different name. 

1 Double-click the Sheet1 sheet tab. 

Sheet1 is selected within the tab. 

2 Type Directory, and press Enter. 

Directory appears in the sheet tab. 

Keep this file open for the next exercise. 

 

 

Closing a Workbook and Quitting 
You can remove a workbook from the window by closing the workbook or by 
quitting Excel. 

1 Click the Close button in the top-right corner of the workbook window. 

The workbook closes. 

2 Click the Close button in the top-right corner of the Excel window. 

Excel closes. 
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Creating a Presentation 

After completing this lesson, you will be able to: 

 
• Start Microsoft PowerPoint. 
• Explore the PowerPoint window. 
• Choose a method to start a presentation. 
• Create a presentation using a wizard. 

• Save a presentation. 

 
 

 
1. Creating a Presentation 

 

With Microsoft PowerPoint, you can create overhead slides, speaker notes, 
audience handouts, and outlines—all in a single presentation file. PowerPoint 
offers powerful tools to help you create and organize a presentation step by 
step. 

 
 
 

Starting Microsoft PowerPoint 
After you install PowerPoint and the practice files, you are ready to start 
PowerPoint. As with other programs, there are several ways to start 
PowerPoint. One way is to use the Start button on the taskbar. 

1 On the taskbar, click Start. 

The Start menu appears. 

2 On the Start menu, point to All Programs. 

The Programs menu appears, displaying all the programs on your hard disk 
drive, including Microsoft PowerPoint. A portion of the Programs menu should 
look like the illustration on the following page. 

3 Click the Microsoft PowerPoint icon to start PowerPoint. 

 
 
tip 

You can also start PowerPoint by creating a shortcut icon on the Windows 
desktop. Simply double-click a shortcut icon to start its associated program. 
To create a shortcut, click the Start button, point to All Programs, right-click 
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Microsoft PowerPoint, point to Send To, and then click Desktop (create 
shortcut). 

A desktop shortcut is represented by an icon with a curved arrow in the left 
corner. 

 
 
 

Exploring the PowerPoint Window 

 
When Microsoft PowerPoint opens, it displays the program window. 
A window is an area of the screen that is used to display a PowerPoint 
program or presentation window. The presentation window is the 
electronic canvas on which you type text, draw shapes, create graphs, add 
color, and insert objects. As with any Microsoft Windows XP program, you can 
adjust the size of the PowerPoint and presentation windows with the Minimize 
and Restore Down/Maximize buttons, and you can close PowerPoint or the 
presentation window with the Close button. 

 
 
Toolbar Options 

The Standard and Formatting toolbars are located directly below the menu 
bar. When PowerPoint is first started, the Standard and Formatting toolbars 
appear on the same row to save window space. Only the most commonly 
used commands appear on the toolbars. 

Outline/Slides Pane 

The default view, Normal, is made up of three panes: Outline/Slides, Slide, 
and Notes. The Outline/Slides pane has tabs that allow you to alternate 
between an outline of the slide text (the Outline tab) and a list of the 
presentation’s slides displayed as thumbnails (Slides tab). The Slide 
pane shows the slide as it will appear in the presentation. The Notes 
pane is where you enter speaker notes. You can resize any of the panes by 
dragging the gray bar that separates them. 

Task Pane 

At the right side of the PowerPoint window is the task pane, as shown in the 
illustration on the following page. The task pane displays commands and 
features you use often in working with presentations. 
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ScreenTip 

Window menu and display a ScreenTip for a button. 

1 On the menu bar, click Window. 

The Window menu appears. 

2 Click the arrows at the bottom of the Window menu to view the 
expanded menu. 

The expanded menu appears. 

3 Click Next Pane. 

4 On the menu bar, click Window again. 

Notice that the Next Pane is now displayed on the Window menu. PowerPoint 
has personalized the Window menu for you. 

Slides Tab 

In this exercise, you look at the Slides tab and use the Other Task Panes 
menu. 

1 Position the pointer on the slide icon in the Slides tab of the 
Outline/Slides pane. 

A ScreenTip appears when you position the pointer over the icon. 

2 Click the Other Task Panes down arrow. 

The Other Task Panes menu opens. 

3 Click an empty place anywhere in the PowerPoint window. 

The Other Task Panes menu closes, leaving the New Presentation task pane 
open. 

Choosing a Method to Start a 
Presentation 
The New Presentation task pane can help you work with existing 
presentations as well as create new ones. If you have already created a 
presentation, you will find its name listed in the Open a presentation section 
of the task pane. If you want to create a new presentation, you can simply 
start adding text to the blank presentation in the Slide pane or use the 
options in the New section of the task pane. 
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■  Click Blank Presentation to start a new presentation from scratch. 

■  Click from Design Template to apply one of PowerPoint’s design 
templates to a new, blank presentation. 

■  Click From AutoContent Wizard to let PowerPoint help you with both 
presentation content and a design. 

 
 

Creating a Presentation Using a 
Wizard 
Creating a presentation with the AutoContent Wizard can save you time by 
helping you organize and write the presentation. The wizard takes you 
through a step-by-step process, prompting you for presentation information, 
beginning with the title slide, which is the first slide in the presentation. 

In this exercise, you create a presentation using the AutoContent Wizard. 

1 In the New Presentation task pane, click From AutoContent Wizard under 
New. 

The New Presentation task pane closes and the AutoContent Wizard dialog 
box opens, displaying the Start screen. On the left side of the dialog box is a 
list of the screens in the wizard. 

tip 

If the Office Assistant appears, click No, don’t provide help now in the help 
screen. 

2 Read the introduction, and then click Next. 

The second screen in the AutoContent Wizard appears, and the square next 
to Presentation type on the left of the dialog box turns green to indicate that 
this is the current screen. The AutoContent Wizard prompts you to select a 
presentation type. To help you identify presentation types quickly, the wizard 
organizes presentations by category. 

3 Click Projects. 

4 In the list on the right, click Project Overview. 

 
 
5 Click Next. 
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The AutoContent Wizard now prompts you to select a media type for the 
presentation. 

6 Click the On-screen Presentation option if necessary to select that 
presentation type. 

7 Click Next. 

The AutoContent Wizard now prompts you to enter information for the title 
slide and for footer information to be included on each slide. 

8 Click in the Presentation title box, type New Employee Training 
Program and then press Tab. 

9 In the Footer box, type Contoso, Ltd. 

10 Verify that the Date last updated and the Slide number check boxes are 
selected. 

 
 
11 Click Next, and then click Finish. 

The PowerPoint presentation window appears with content provided by the 
AutoContent Wizard in outline form in the Outline tab of the Outline/Slides 
pane and the title slide in the Slide pane. The name on the title slide is the 
name of the registered user. 

 
 
 

Saving a Presentation 
The work you have completed so far is stored only in your computer’s 
temporary memory. To save your work for further use, you must give the 
presentation a name and store it on your computer’s hard disk drive. 

 
 
In this exercise, you save a presentation. 

Almost every dialog box includes a question mark button in the upper-right corner of its window. 

When you click this button and then click any dialog box control, a Help window appears that 

explains what the control is and how to use it. 
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1 On the Standard toolbar, click the Save button. 

PowerPoint displays the Save As dialog box, as shown in the illustration on 
the following page. The text in the box next to the label File name is selected 
so that you can type a presentation name. 

 
 
2 In the File Name box, type Contoso Employee Training Report Pres 01. 

The word Pres in the file name is an abbreviation for Presentation. 

3 Click the Save In down arrow, and then click drive C. 

4 In the list of file and folder names, double-click the Computer 
Fundamentals Practice folder, then the Part V folder, and then double-click 
the Lesson01 folder. 

5 Click Save or press Enter to save the presentation. 

The title bar name changes from Presentation1 to Contoso Employee Training 
Report Pres 01. 

tip 

Creating a Presentation 

After completing this lesson, you will be able to: 

 
• Start Microsoft PowerPoint. 
• Explore the PowerPoint window. 
• Choose a method to start a presentation. 
• Create a presentation using a wizard. 

• Save a presentation. 

 
 

 
1. Creating a Presentation 

 

With Microsoft PowerPoint, you can create overhead slides, speaker notes, 
audience handouts, and outlines—all in a single presentation file. PowerPoint 
offers powerful tools to help you create and organize a presentation step by 
step. 
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Starting Microsoft PowerPoint 
After you install PowerPoint and the practice files, you are ready to start 
PowerPoint. As with other programs, there are several ways to start 
PowerPoint. One way is to use the Start button on the taskbar. 

1 On the taskbar, click Start. 

The Start menu appears. 

2 On the Start menu, point to All Programs. 

The Programs menu appears, displaying all the programs on your hard disk 
drive, including Microsoft PowerPoint. A portion of the Programs menu should 
look like the illustration on the following page. 

3 Click the Microsoft PowerPoint icon to start PowerPoint. 

 
 
tip 

You can also start PowerPoint by creating a shortcut icon on the Windows 
desktop. Simply double-click a shortcut icon to start its associated program. 
To create a shortcut, click the Start button, point to All Programs, right-click 
Microsoft PowerPoint, point to Send To, and then click Desktop (create 
shortcut). 

A desktop shortcut is represented by an icon with a curved arrow in the left 
corner. 

 
 
 

Exploring the PowerPoint Window 

 
When Microsoft PowerPoint opens, it displays the program window. 
A window is an area of the screen that is used to display a PowerPoint 
program or presentation window. The presentation window is the 
electronic canvas on which you type text, draw shapes, create graphs, add 
color, and insert objects. As with any Microsoft Windows XP program, you can 
adjust the size of the PowerPoint and presentation windows with the Minimize 
and Restore Down/Maximize buttons, and you can close PowerPoint or the 
presentation window with the Close button. 
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Toolbar Options 

The Standard and Formatting toolbars are located directly below the menu 
bar. When PowerPoint is first started, the Standard and Formatting toolbars 
appear on the same row to save window space. Only the most commonly 
used commands appear on the toolbars. 

Outline/Slides Pane 

The default view, Normal, is made up of three panes: Outline/Slides, Slide, 
and Notes. The Outline/Slides pane has tabs that allow you to alternate 
between an outline of the slide text (the Outline tab) and a list of the 
presentation’s slides displayed as thumbnails (Slides tab). The Slide 

pane shows the slide as it will appear in the presentation. The Notes 
pane is where you enter speaker notes. You can resize any of the panes by 
dragging the gray bar that separates them. 

Task Pane 

At the right side of the PowerPoint window is the task pane, as shown in the 
illustration on the following page. The task pane displays commands and 
features you use often in working with presentations. 

 
 
ScreenTip 

Window menu and display a ScreenTip for a button. 

1 On the menu bar, click Window. 

The Window menu appears. 

2 Click the arrows at the bottom of the Window menu to view the 
expanded menu. 

The expanded menu appears. 

3 Click Next Pane. 

4 On the menu bar, click Window again. 

Notice that the Next Pane is now displayed on the Window menu. PowerPoint 
has personalized the Window menu for you. 

Slides Tab 

In this exercise, you look at the Slides tab and use the Other Task Panes 
menu. 
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1 Position the pointer on the slide icon in the Slides tab of the 
Outline/Slides pane. 

A ScreenTip appears when you position the pointer over the icon. 

2 Click the Other Task Panes down arrow. 

The Other Task Panes menu opens. 

3 Click an empty place anywhere in the PowerPoint window. 

The Other Task Panes menu closes, leaving the New Presentation task pane 
open. 

Choosing a Method to Start a 
Presentation 
The New Presentation task pane can help you work with existing 
presentations as well as create new ones. If you have already created a 
presentation, you will find its name listed in the Open a presentation section 
of the task pane. If you want to create a new presentation, you can simply 
start adding text to the blank presentation in the Slide pane or use the 
options in the New section of the task pane. 

■  Click Blank Presentation to start a new presentation from scratch. 

■  Click from Design Template to apply one of PowerPoint’s design 
templates to a new, blank presentation. 

■  Click From AutoContent Wizard to let PowerPoint help you with both 
presentation content and a design. 

 
 

Creating a Presentation Using a 
Wizard 
Creating a presentation with the AutoContent Wizard can save you time by 
helping you organize and write the presentation. The wizard takes you 
through a step-by-step process, prompting you for presentation information, 
beginning with the title slide, which is the first slide in the presentation. 

In this exercise, you create a presentation using the AutoContent Wizard. 

1 In the New Presentation task pane, click From AutoContent Wizard under 
New. 
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The New Presentation task pane closes and the AutoContent Wizard dialog 
box opens, displaying the Start screen. On the left side of the dialog box is a 
list of the screens in the wizard. 

tip 

If the Office Assistant appears, click No, don’t provide help now in the help 
screen. 

2 Read the introduction, and then click Next. 

The second screen in the AutoContent Wizard appears, and the square next 
to Presentation type on the left of the dialog box turns green to indicate that 
this is the current screen. The AutoContent Wizard prompts you to select a 
presentation type. To help you identify presentation types quickly, the wizard 
organizes presentations by category. 

3 Click Projects. 

4 In the list on the right, click Project Overview. 

 
 
5 Click Next. 

The AutoContent Wizard now prompts you to select a media type for the 
presentation. 

6 Click the On-screen Presentation option if necessary to select that 
presentation type. 

7 Click Next. 

The AutoContent Wizard now prompts you to enter information for the title 
slide and for footer information to be included on each slide. 

8 Click in the Presentation title box, type New Employee Training 
Program and then press Tab. 

9 In the Footer box, type Contoso, Ltd. 

10 Verify that the Date last updated and the Slide number check boxes are 
selected. 

 
 
11 Click Next, and then click Finish. 

The PowerPoint presentation window appears with content provided by the 
AutoContent Wizard in outline form in the Outline tab of the Outline/Slides 
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pane and the title slide in the Slide pane. The name on the title slide is the 
name of the registered user. 

 

 
 

Saving a Presentation 
The work you have completed so far is stored only in your computer’s 
temporary memory. To save your work for further use, you must give the 
presentation a name and store it on your computer’s hard disk drive. 

 
 
In this exercise, you save a presentation. 

Almost every dialog box includes a question mark button in the upper-right corner of its window. 

When you click this button and then click any dialog box control, a Help window appears that 

explains what the control is and how to use it. 

 

 

 

 

 

 

1 On the Standard toolbar, click the Save button. 

PowerPoint displays the Save As dialog box, as shown in the illustration on 
the following page. The text in the box next to the label File name is selected 
so that you can type a presentation name. 

2 In the File Name box, type Contoso Employee Training Report Pres 01. 

The word Pres in the file name is an abbreviation for Presentation. 

3 Click the Save In down arrow, and then click drive C. 

4 In the list of file and folder names, double-click the Computer 
Fundamentals Practice folder, then the Part V folder, and then double-click 
the Lesson01 folder. 

5 Click Save or press Enter to save the presentation. 

The title bar name changes from Presentation1 to Contoso Employee Training 
Report Pres 01. 

Tip 
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How to Print File 

Learning Objectives: 

After reading this information sheet, YOU MUST be able to identify 
the computer hardware. 

 
 
 
1. How to Print File 

 

Printing Document 

Steps 

1. Open a program that allows you to insert text into a document or get on 
the internet. 

2. If you were to open a program, you would need to type text into the 
document. If you were to get on the internet, you could skip to step 7. 

3. After you have typed text into the document, you need to locate the 
menu bar, click on file, then point to print. 

4. Click on print.\ 

5. When the print dialog box appears, select the printer you want to use (if 
it is not already selected) and select the number of copies to print. 

6. Click OK. 

7. If you were to print a page or pages from the internet, follow steps 3, 4, 
5, and 6, except you don't have to type text into a document to print. 

Printing Spreadsheet 

 

 
1. Format your spreadsheet the way you want to see it printed. Add 
borders and shading as necessary to your tables and adjust column widths 
so your data fits without overlapping. The better job you do preparing your 
spreadsheet from the beginning, the easier it will be to print. Include features 
like headers and footers to ensure all the necessary information will be on 
the printout. 

 

 
2. Change the screen view from normal mode to print view mode. For 
Microsoft Excel, click "View" on the menu bar and then click "Page Break 
Preview." Other spreadsheets will likely have a similar process. If not, go to 
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the "Print Preview" page and, if necessary, turn on the margins by clicking 
the appropriate button--usually "Margins." 

3. 

3. Adjust the page breaks or margins by clicking on them and dragging them 
in the direction you want them adjusted. Sometimes, the scale will 
automatically adjust to fit your new margin or page-break definitions. If not, 
you will have to do it manually. 

4. Go to your spreadsheet's "Page Setup" function, usually in the "File" menu, 
if you must manually adjust the scale. There are three types of adjustments 
you may see. The first option is to choose between "Landscape" and 
"Portrait." The former is better for wide, continuous spreadsheets, while the 
latter is good for narrow or limited-length tables. The second adjustment is to 
fit the spreadsheet to a set number of pages in length and in width. The 
scale is automatically adjusted to meet the criteria you define. The final 
option is to choose a percentage adjustment from the original size. This can 
work to enlarge or reduce the final printout. 

4. Click the "Print" button on the toolbar once all of the adjustments are 
made. There is no way to determine exactly how the spreadsheet will look 
when it is finally on paper, so you may have to go back and fine-tune some 
of your adjustments in order to print out a copy that is professional and 
readable, especially for extremely wide or complex spreadsheets. 

Printing Slides in Power Point 

 
 

Set the slide size and orientation for printing 

To change your printing options, do the following: 

1. On the Design tab, in the Page Setup group, click Page Setup. 

2. In the Slides sized for list, click the size of paper on which you will be 
printing. 

NOTES 

· If you click Custom, type or select the measurements that you want in 
the Width and Height boxes. 

· To print an overhead transparency, click Overhead. 

3. To set the page orientation for the slides, under Orientation, 
under Slides, clicks Landscape or Portrait. 
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NOTE By default, PowerPoint slide layouts appear in landscape orientation. 
Although you can use only one orientation (either landscape or portrait) in a 
presentation, you can link two presentations to display both portrait and 
landscape slides in what appears to be one presentation. For more 
information, see Use portrait and landscape slide orientation in the same 
presentation. 

TOP OF PAGE 

Print the slides 

1. Click the Microsoft Office Button , and then click Print. 

· In the Print dialog box, under Print range, do one of the following: 

· To print all slides, click All. 

· To print the slide that is currently displayed, click Current slide. 

· To print one or more slides that you selected, click Selection. 

· To print specific slides numbers, click Slides, and then enter the slide 
numbers or ranges in the adjoining box. 

2. Under Copies, enter the number of copies that you want. 

3. Under Print What, select Slides. 

NOTES 

· For information about printing handouts, see Create and print 
handouts. 

· If you select Outline view, PowerPoint prints only the text of your 
slides (as it appears in outline view) and none of the graphics or animation. 

4. Under Color/Grayscale, click one of the following: 

· Color If you print to a color printer, this option prints in color. 

· Color (On Black and White Printer) If you print to a black-and- 
white printer, this option prints in grayscale. 

· Grayscale This option prints images that contain variations of gray 
tones between black and white. Background fills are printed as white, so that 
the text will be more legible. (Sometimes grayscale appears the same 
as Pure Black and White.) 

· Pure Black and White This option prints the handout with no gray 
fills. 
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5. To increase resolution, blend transparent graphics, and print soft shadows 
in your print job, select the High quality check box. 

TIP When you print in high quality, it may take longer for your presentation 
to print. To prevent a possible decrease in your computer's performance, 
clear the High quality check box after you finish printing. 

6. To print your slides on the paper that you selected for your printer, select 
the Scale to fit paper check box. 

7. To print a thin border around your slides, select the Frame slides check 
box. 

8. Click Print. 

NOTES 

· If you want to reset the print options and keep them as your default 
settings, do the following: 

1. Set the settings as you want them in the Print dialog box. 

2. Click the Microsoft Office Button , click PowerPoint Options, and 
then click Advanced. 

3. Under When printing this document, click Use the most recently 
used print settings. 

· If you are creating transparencies for an overhead projector, see Set 
the slide size and orientation for printing. PowerPoint automatically optimizes 
your slides for either black and white or color printers. 

 

 
MAINTAIN COMPUTER SYSTEM 

Learning Objective: 

After reading this INFORMATION 
SHEET, YOU MUST be able to Maintain 
Computer System 
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1. How to perform Disk Clean Up? 
 

How to perform Disk Clean Up: 

 
1. Start Menu>>Programs>>Accessories>>System Tools>>Disk Clean Up 

2. Select Drive to Clean Up and click “OK” 

3. Place Check Marks in Items to be removed Click “OK” 

(If your not sure what you are deleting select the category and then Click 
“View Files”) 

 

 
 

How to Clear Internet “History” 
1. Start Menu>>Settings>>Control Panel>>Dbl Click Internet Options 

2. Click “Clear History” 

3. Click “OK” 
 

 
 

How to Clear Internet “Temporary Internet” Files 

1. Start Menu>>Settings>>Control Panel>>Dbl Click Internet Options 

2. Click “Delete Files” 

3. Put check mark in “Delete all Offline Content” 

4. Click “OK” 

5. Click “OK” again 

 
 

How to Run Scan disk and Disk Defragmenter without interruption: 

Start Menu>>Run >>In Run Type “MSCONFIG” then click “OK” 

MSCONFIG will appear 

Select “Selective Startup” then Uncheck 

“Load Startup Group Items” 

Click “OK” 
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Click Yes to Restart Computer 

Upon Restart 

Start Menu>>Settings>>Control Panel>>Dbl Click Display 

Select the “Screen Saver” Tab 

Change the Screen Saver Drop Menu to “NONE” 

 
Click OK 

Then Perform Scan Disk: 

Start Menu>>Programs>>Accessories>>System Tools>>Scan Disk 

 
After Scan Disk Perform Disk Defragmenter 

Start Menu>>Programs>>Accessories>>System Tools>>Disk Defragmenter 
Select which disk to Defragment then click “OK” 

 
After Disk Defragmenter 

Start Menu>>Run >>In Run Type “MSCONFIG” then click “OK” 
MSCONFIG will appear>>select “Normal Start Up” and Click “OK” 
Click Yes to Restart Computer 

 
Upon Restart 

Start Menu>>Settings>>Control Panel>>Dbl Click Display 

Select the “Screen Saver” Tab>>Change the Screen Saver Drop Menu to 
your preferred screen saver 

Click OK 

 

 
 

 
 

 
Removing viruses from infected machines 
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Computer Virus 

§ A virus is a destructive executable program that infects the other 
programs in the system and spreads by replicating itself. 

§ Such a program is designed to damage the victim’s computer files. 

§ Viruses are coded by malicious programmers in a way that they can 
spread in the system without one's permission and knowledge. 

Different Aspects of Computer Virus 

Finder- searches for the new uninfected files and the 

Replicator- actually targets these files and infects it by multiplying itself. 

How Virus does Affects a System? 

 
• It corrupts files 
• It slows down the speed of the computer system 
• It causes the system to hang frequently 

• It deletes various files 

Sources of Virus Infection 

A virus can enter the system and infect it through various sources. Some of 
the sources are 

 

• Infected CDs, DVDs, pen drives, etc 
• E-mail 
• Browsing infected sites 

• Downloading files from the internet 

Steps to Remove Viruses 

Removing viruses, though technical, is yet a very simple process if all the 
required steps are properly followed. 

The basic steps are: 
 

• Buy or download an antivirus software 
• Install the antivirus software 
• Update antivirus software with the latest virus definitions 

• Do a complete system scan 
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Methods of Eliminating Viruses 

Removing the virus – When the virus can be easily identified and can be 
removed without affecting other files, then the antivirus removes it from the 
host place. 

Quarantine – This is done when the virus cannot be easily identified 

removed from the file and the removal of virus means the removal of the 
complete file. In this method, although the virus is not eliminated, it is 
rendered inactive by moving the file into "quarantine" and renaming it. 

Types of viruses and Examples 

Boot viruses: These viruses infect floppy disk boot records or master boot 
records in hard disks. They replace the boot record program (which is 
responsible for loading the operating system in memory) copying it 
elsewhere on the disk or overwriting it. Boot viruses load into memory if the 
computer tries to read the disk while it is booting. 

 

 
Examples: Form, Disk Killer, Michelangelo, and Stone virus 

Program viruses: These infect executable program files, such as those with 
extensions like .BIN, .COM, .EXE, .OVL, .DRV (driver) and .SYS (device driver). 
These programs are loaded in memory during execution, taking the virus 
with them. The virus becomes active in memory, making copies of itself and 
infecting files on disk. 

 

 
Examples: Sunday, Cascade 

Multipartite viruses: A hybrid of Boot and Program viruses. They infect 
program files and when the infected program is executed, these viruses 
infect the boot record. 

Examples: Invader, Flip, and Tequila 

Stealth viruses: These viruses use certain techniques to avoid detection. 
They may either redirect the disk head to read another sector instead of the 
one in which they reside or they may alter the reading of the infected file’s 
size shown in the directory listing. size given in the directory. 

 

 
Examples: Frodo, Joshi, Whale 
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Polymorphic viruses: A virus that can encrypt its code in different ways so 
that it appears differently in each infection. These viruses are more difficult 
to detect. 
Examples: Involuntary, Stimulate, Cascade, Phoenix, Evil, Proud, Virus 101 

Macro Viruses: A macro virus is a new type of computer virus that infects the 
macros within a document or template. When you open a word processing or 
spreadsheet document, the macro virus is activated and it infects the Normal 
template. 
Examples: DMV, Nuclear, Word Concept. 

Antivirus Software 

Software designed to cure virus infected machines. An antivirus is a program 
that searches for, identifies and removes potential viruses existing in the 
computer system 

Examples of Anti-virus software 
 

• Symantec Norton antivirus 
• AVG antivirus 
• McAfee Scan 

• Microsoft Antivirus 

Back up your files 
As our world becomes more digitized, the files we store on our computers are 
becoming increasingly more important. Instead of keeping handwritten 
letters in a shoebox, we correspond with family members using e-mail. If we 
use digital cameras, we often keep our photo albums on our computers. 

Unfortunately, computers (and particularly the hard disk drives that hold 
your files) can fail. Your computer might run for a decade with no problems, 
or it could fail tomorrow—there's no way to tell. To make sure you don't lose 
important files if your computer stops working, you should back up your 
computer on a regular basis. The backup process copies your files to a safe 
place so that even if your computer fails, you won't lose them. 

Choose backup storage 

It doesn't make sense to back up your files to the hard disk drive inside your 
computer, because if your computer were to fail, you would also lose your 
backup. Instead, you should back up your files to an external hard disk drive 
or removable disk drive, such as a CD. If your computer does fail, you can 
then connect the external hard disk drive or use the CDs to restore your files 
to your new or repaired computer. (This article describes how to back up 
your files to an external hard disk drive, which is the easiest way to do a full 
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backup of all your files. If you decide to use CDs, you'll need to choose which 
files to back up and then manually insert and remove CDs as they are filled.) 

If you decide to get an external hard disk drive, choose one that is at least as 
large as the hard disk drive inside your computer. For example, if your 
computer has a 100-gigabyte (GB) hard disk drive, choose a 100-GB or larger 
external hard disk drive. Then connect the external hard disk drive to your 
computer. Make a note of the drive letter (such as E:, F:, or G:) assigned to 
your new hard disk drive. 

With an external hard disk drive, you can manually back up your files, or you 
can schedule automatic weekly backups. 

Manually back up your files 

To back up your files to an external hard disk drive 

1. Click Start, point to Accessories, point to System Tools, and then click Backup. If 

the Backup option does not appear on the System Tools menu, you can install it. 

2. The Backup or Restore Wizard appears. Click Next. 

3.On the Backup or Restore page, click Next. 

4. On the What to Back Up page, click All information on this computer, and then click Next. 

5. On the Backup Type, Destination, and Name page, click Choose a place to save your 

backup, and select your external hard disk drive. Then click Next. 

6. On the Completing the Backup or Restore Wizard page, click Finish. 

7. Windows Backup saves a copy of your files to your external hard disk drive. When the backup 

is complete, click Close. 

If your computer stops responding, you will be able to restore your files to 
the state they were in when you completed the backup. However, any new 
files you have created and any changes you have made to existing files since 
the backup occurred will not be saved unless you back up your files again. 
For best results, back up your files every week or immediately after creating 
important files, such as after you copy pictures from your digital camera. 

For an additional layer of protection, purchase a second external hard disk 
drive and perform another backup of your hard disk drive. Store this external 
hard disk drive in a different location, such as at a family member's house, to 
protect your files from theft, fire, or natural disasters that might damage 
both your computer and your backup. 
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Schedule backups 

If you're busy, you might not have time to manually back up your files every 
week. Fortunately, you can schedule backups to occur automatically. This 
takes a few minutes to set up, but once you've done so, you'll be protected 
indefinitely. 

To schedule a weekly backup 

1. Click Start, point to Accessories, point to System Tools, and then click Backup. If 

the Backup option does not appear on the System Tools menu, you can install it. 

2. The Backup or Restore Wizard appears. Click Next. 

 

 
3. On the Backup or Restore page, click Next. 

4. On the What to Back Up page, click All information on this computer, and then 

click Next. 

5. On the Backup Type, Destination, and Name page, click Choose a place to save your 

backup, and select your external hard disk drive. Then click Next. 

6. On the Completing the Backup or Restore Wizard page, click Advanced. 

7.On the Type of Backup page, click Next. 

8. On the How to Back Up page, click Next. 

9. On the Backup Options page, select Replace the existing backups. Then click Next. 

10.On the When to Back Up page, click Later. In the Job name box, type Backup. Then 

click Set Schedule. 

11. On the Schedule tab in the Schedule Job dialog box, click the Schedule Task list, and then 

click Weekly. 

12. In the Start time box, specify a time of day when your computer will not be used for 

several hours, such as 3:00 AM. In the Schedule Task Weekly area, select the day of the 

week you want to back up your files. If you are backing up files overnight, remember to 

leave your computer running the night before. 

3.Click the Settings tab. Select the Wake the computer to run this task check box. 

4.Click OK. 

5. In the Set Account Information dialog box, type your password in both 

the Password and Confirm password fields. Then click OK. 

6. On the When to Back Up page, click Next. 
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7. In the Set Account Information dialog box, type your password in both 

the Password and Confirm password fields. Then click OK. 

8. In the Account Information Warning dialog box, click OK. 

9. On the Completing the Backup or Restore Wizard page, click Finish 

Your computer will automatically back up your files to your external hard disk 
drive every week at the time you specified. 

 
How to change an installed program 

Note You cannot use this feature to modify all programs. 

 
You can use this feature to change the installation of Windows Installer-based 
programs such as Microsoft Office XP. Windows Installer-based programs 
include a Maintenance Mode option. With this option, you can add or remove 
features, change the installation state of the program or of individual 
components, or repair and restore the installation. 

 
To change a program, follow these steps: 

 
1. Click Start, click Control Panel, and then double-click Add or Remove 

Programs. 
2. In the Currently installed programs box, click the program that you want 

to remove, and then click Change or Change/Remove. 
3. Follow the instructions that appear on the screen to make the changes that 

you want. 

 
How to remove an installed program 

To remove a program that is installed on your computer, follow these steps: 
 

1. Click Start, click Control Panel, and then double-click Add or Remove 
Programs. 

2. In the Currently installed programs box, click the program that you want 
to remove, and then click Remove. 

3. If you are prompted to confirm the removal of the program, click Yes. 

 
Troubleshooting 

 
• Make sure that the program that you click in the Add or Remove Programs 

tool is the program that you want to remove from your computer. Some 
programs may not prompt you to confirm the removal before the program is 
removed from the computer. 

• You can only remove a program with the Add or Remove Programs tool if the 
program is written for Windows. If you do not see the program that you want 
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to remove in the currently installed programs box, view the program 
documentation for instructions about how to remove it. 
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